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1 ABOUT THIS MANUAL 

1.1 List of Abbreviations: 

ASD  - Alpha Spike Detector 

DAP - Data Acquisition Processor 

EPS - Electrode Positioning System 

MCP - Multi Channel Processor 

MSD  - Multi-Spike Detector 

PSTH - Peri-Stimulus Histogram 

 

 

1.2 Reference Documents: 

AlphaLab SnR User Manual 

AlphaMap User Manual 
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2 INTRODUCTION 

The File Converter Application is a file utility supplied with the AlphaLab and AlphaMap 

products.  It provides the user with three main functions: 

 Convert files from map or mpx format to other formats 

 Merge map or mpx files together  

 Post-Process files to prepare them for offline analysis  

 

The convertor runs on Windows XP or Windows 7 32bit or 64bit systems.  

 

2.1 Starting the Map Converter Application 

There are two ways to start the Map Converter application: 

 Under AlphaLab 

1. From the AlphaLab Pro Server/Client application. 

Click the Converter icon. or  

2. Select Start > All Programs > AlphaLab > Off Line Applications > 

Converter 

 Under AlphaMap or AlphaLab SnR 

1. Click on the Mapfile Icon on the Desktop, or  

2. Select Start > All Programs > AlphaMap > MAP Converter 

In all cases, the main “Map Converter” window appears (See Figure 1): 
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Figure 1: Main Map Converter window 

Important:  The main GUI, its menu item, and its tool bar item may look different based 

on the file you open.  This manual covers all options.  

3 FILE CONVERSION 

Data Acquisition under AlphaLab or AlphaMap stores all its output data files in binary 

format using Alpha Omega proprietary map format, or other vendor formats. The map 

files may need to be converted to other formats for further processing.  This is where the 

Map Converter comes in handy; hence it is a special conversion program that allows 

converting files from binary map format to text, matrix, Matlab, or other vendor formats.  

Step-by-Step Conversion 

Loading a Binary File 

Five types of files may be loaded for conversion: 

 Files with a “.mpx” extension: 

o These are real AlphaLab SnR binary data files. 

 Files with a “.lsx” extension: 

o These are text files that contain a list of mpx files. When a “.lsx” 

file is opened, all files listed within it are loaded for conversion. 

 Files with a “.map” extension: 

o These are real AlphaMap or TeleSpike binary data files. 

 Files with a “.lsm” extension: 
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o These are text files that contain a list of map files. When a “.lsm” 

file is opened, all files listed within it are loaded for conversion. 

 Matlab files with a “.mat” extension. 

o These are Matlab Files that may be created by labs. 

 

To load a binary file, select the File->Open menu option (see Figure 2) or use the Open 

button on the tool bar. The file name selection dialog box appears (see Figure 3). 

 

Figure 2: File Menu 

 

Figure 3: File names selection 

Select the desired file and click the OPEN button. This operation loads the file from disk, 

opens a window for each “.map” file and starts scanning the data (see Figure 4). Each 

window has the name of the file specified at the top and shows other information 

available for that file. 
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Figure 4: Binary file Specification Windows 

3.1 The Scanning Process  

The scanning process determines the minimum and/or maximum timestamps for each 

channel. These timestamps may be needed for the creation of the matrix or the Matlab file 

format. The scanning process also outputs information into the text file “trace_mf.dat” 

about erased signals and corrupted parts of the source files. This file is stored in the same 

directory where the conversion program is located. 

To interrupt the scanning process, click the File Converter’s Close button - located at the 

upper right corner of the main window. The following message box appears: 

 

Figure 5: Interrupting the Scanning Process  

Once the scanning has ended or been interrupted, it becomes possible to perform other 

functions or queries on the Binary File Specification Windows (see Figure 6). 



 

Map/mpx File Converter Version 5.1.8 - 6 - 

 

 

Figure 6: Binary File Specification Window in the ‘Ready’ State 

3.2 Examine the File Scan Results 

To look at the results of the scan, select the “Scanning” option from the “Information” 

menu. The dialog “Result of scanning” appears (see Figure 7) showing trace data 

applicable to the active Binary File Specification Windows. 

 

Figure 7: Scanning process information 
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To view additional information about channels, select the “Analog Input” option from 

the “Information” menu, and the “Analog Input” dialog box appears (see Figure 8). 

Select the desired Board, and the desired channel from the list box. 

 

Figure 8: Analog Input Dialog Box 

To select channels for conversion and set the desired sample times, select the item 

“Input definition” from the “Options” menu. The “All Channels” dialog box appears 

(see Figure 9). 
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Figure 9: ‘All Channels’ Dialog Box 

This dialog box contains the properties for all channels and shows the minimum and 

maximum sample times in the source file. The program converts data of the defined time 

interval only for channels in which the checkboxes are turned on . To convert all data 

to text or matrix format, enter the value “-1 ” in both fields of the “Type times for 

desired Samples:” otherwise enter the minimum and maximum sample times desired. 

To select all channels, click the “Select All” button. To select one or more channels, mark 

the appropriate checkbox and click the “Select” button. To deselect all channels, click the 

“UnSelect All” button. To deselect one or more channels, select the appropriate channel 

and click the “UnSelect” button. To select or deselect one channel double click the left 

mouse button on the appropriate checkbox. 

3.3 Stream Format Data Conversion 

Files saved using the AlphaLab SnR system may contain stream format records, which 

are records of text messages keyed by the user, or records of changes made by the user 

such as detection level changes, online sorting template changes, and others.   Converting 

files created by the AlphaLab SnR to any format will result in additional text files 

containing the stream data.  Converting files to Matlab format also puts each type of the 

stream format records in a Matlab variable or table.  The Converter allows selecting what 

types of stream records to output by using “Options/Stream Format Definition…” option 

and selecting the desired commands.  The figure below shows the window that allows 

selecting the commands. 
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Figure 10 - Stream Command Selection Window 

     

 

The figures below shows an example of converting several mpx file to Matlab format 

showing the generated stream format text files. 

 

Figure 11: Converting Files containing Stream Format Data 

The window below also shows the contents of one of those text files. 
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Figure 12: Stream format converted file 

In the beginning of each file you will find a large group of lines that specify the statuses 

of each parameter in in the beginning of the file, and then afterward, every time there is a 

change, a line is added.  Each record or line will have a time stamp, an ID, and a string of 

formatted data as to what it relates to in the shape of parameters and their values, 

separated by a space. The table below shows a list of ID’s, their formats and an 

explanation. 

 

ID Use Parameters Meaning 

1 Channel 

Acquisition on/off 

Ch=Channel ID Channel ID number 

Acquisition=<0/1> Acquisition is off/on 

2 Sampling Rate Ch=Channel ID Channel ID number 

DownSample=<1/2/4/8/16/32/> Down sampling factor from maximal 

sampling rate 

3 Detection level 

line value 

Ch=Channel ID Channel ID number 

Level=(Value,Slope) Value is A/D value 

Slope is Up/Down 

4 Filtering 

parameters 

Note: In older 

system that use 

maximal sampling 

rate of 44632, 

values here are 

not exactly as 

selected in the 

GUI, but they are 

rather rounded 

value, for example 

179 will appear 

here as 200. 

Ch=Channel ID Channel ID number 

LP=<HW/Value Hz> HW – No digital filter applied 

Value = Low pass filter in Hz.  

HP=<HW/value Hz> HW – No digital filter applied 

Value = High pass filter in Hz.  
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ID Use Parameters Meaning 

5 Reference 

electrode 

Ch=Channel ID Channel ID number 

Ref=<0/Channel ID> 0 – No referencing 

Channel ID of the reference electrode 

Active=<0/1> Not used yet.  Having a channel ID in 

the Ref field means that it is active. In 

the future it will be used as follows: 

Referencing is deactivated/activated 

when reference channel is specified 

100 Online sorting 

template definition 

Ch=Channel ID Channel ID number 

T=<1/2/3/4> Template Number 

Points=(Index1,Value1),(Index

2,Value2),…,(Index8,Value8) 

Indices and values of the 8 template 

points in relation to the 96 samples.  

Value in in A/D  

101 Template 

detection threshold 

and noise values 

Ch=Channel ID Channel ID number 

T=<1/2/3/4> Template Number 

Threshold=Value Value of detection threshold 

Noise=Value Value of noise threshold 

102 Template 

detection is on/off 

Ch=Channel ID Channel ID number 

T=<1/2/3/4> Template Number 

Active=<0/1> Template is off/on 

103 Template Window 

discriminator (I) 

definition 

Ch=Channel ID Channel ID number 

T=<1/2/3/4> Template Number 

Disc=<1/2/3> Discriminator number 

Active=<0/1> Discriminator is off/on 

Sample=Index Index of the sample number where the 

discriminator in defined.  Exists only 

when active. 

Range=(Bottom,Top) Values in A/D of the bottom and top 

of the discriminator. Exists only when 

active. 

150 Text Message 

from GUI 

Text=String String is the message keyed by the 

user using the events dialog in the 

GUI. 

151 Print message 

from Script 

Print=String String is the message printed by the 

Script.  

200 Contact type Ch=Channel ID Channel ID number 

ContactType=<MICRO/EMG/

EEG/EKG/MACRO/AI/AO/DP

I/DPO/TTL/NotDefined> 

Contact type 

201 Headstage gain Ch=Channel ID Channel ID number 

Gain=float Headstage gain applied 

202 PreAmp Settings Ch=Channel ID Channel ID number 
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ID Use Parameters Meaning 

PreAmp=<0/float> 0 = No Preamp 

Float > 0 = Preamp exists and float is 

the gain  

203 Impedance sine 

wave values 

Ch=Channel ID Channel ID number 

Amp=Value Amplitude of sine wave is mVolts 

Freq=Value Frequency of sine wave in Hz 

204 Impedance value 

measured 

Ch=Channel ID Channel ID number 

Impedance=Value Impedance value in KOhm 

205 Electrode 

grounding 

Ch=Channel ID Channel ID number 

GND=<0/1> Electrode in Not grounded/grounded 

at the headstage input 

206 Electrode position 

reported by the 

EPS software  

Ch=Channel ID Channel ID number 

AbsDepth=Value (float) Absolute Depth 

RelDepth=Value (float) Relative Depth (if different from 

absolute depth this means that “Set 

Zero” was used in EPS) 

207 Contact total gain  Ch=Channel ID Channel ID number 

TotalGain=float Total gain applied 

  

250 Animal Position 

reported by 

EthoVision 

(Noldus) 

Arena=integer Number of arena 

Subject=integer Number of subject tracked 

Trial=integer Number of trial 

FN=integer Frame number 

FM=integer Frames missing 

Cog_X X position of the center of gravity in 

cm if EthoVision used cm 

Cog_Y Y position of the center of gravity in 

cm if EthoVision used cm 

Cog_Z Z position of the center of gravity in 

cm if EthoVision used cm 

Nose_X X position of the nose (if selected) in 

cm if EthoVision used cm 

Nose_Y Y position of the nose (if selected) in 

cm if EthoVision used cm 

Nose_Z Z position of the nose (if selected) in 

cm if EthoVision used cm 

Tail_X X position of the tail (if selected) in 

cm if EthoVision used cm 

Tail_Y Y position of the tail (if selected) in 

cm if EthoVision used cm 

Tail_Z Z position of the tail (if selected) in 
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ID Use Parameters Meaning 

cm if EthoVision used cm 

251 Video Frame 

information 

reported by 

Norpix 

FN=integer Frame number 

RelativeTime=double Relative time in seconds from 

beginning of video recording 

 

3.4 Convert a Binary File to Matlab Format 

After loading the binary file(s), the ‘File’ menu will contain three new groups of menu 

items. One group is for conversion to text files, the second is for matrix files, and the third 

group is for conversion to the Matlab file format (see Figure 13). Also, corresponding 

tool bar buttons will be available for use. 

 

Figure 13: File menu options 

Before starting conversion to Matlab file format, setting the Matlab file creation options 

may be required. For this purpose, select the item “Convert to Matlab format Options” 

from menu “Options” – then the dialog ‘Matlab file creation options’ appears (see 

Figure 14).  Options shown in the figure below are the default options.  
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Figure 14: Matlab file creation options 

If you check the “Convert channels sequentially” option, then data is converted to 

Matlab format one channel at a time. Every time data for one channel is converted and 

written to the output file, the source file is read from the beginning to convert and write 

data for the next channel. When the option “Convert channels together” is selected, 

which uses less memory, the status bar will show “all channels”. 

To convert to the Matlab format; change the sampling rate of a channel by selecting the 

appropriate row, clicking on the last column and typing the desired value. To refresh this 

specific value, click the button “Current”. To refresh all values in the column “New 

Sampling rate (KHz)”, click the button “All”. 

Convert Segmented without zero padding – If this is checked, which is the default, that 

mean the converter will arrange segmented data each segment in its own row in the 

Matlab table, and each row will have a corresponding time stamp.  Otherwise, all 

segmented data will be converted to a continuous row by filling zeroes between the 

segments.  

Build Gap table when trials are saved to same file – If this is not checked, which is the 

default, that mean if the SnR of AlphaMap saved files using the digital trigger but used 

same file for saving, then the converter pad the gaps between the files with zeroes.  This 

may make the files extremely big.  If this option is checked and a gap time is specified, 

the converter will save all data consecutively, and it will also save a 2 dimensional table 

that tells the user where the gaps where in the file.  This table will have an entry every 

time the gap was more than the specified time, and the entry will have an index of where 

the gap is and the number of samples.   

 

Build Channel Variables as a Struct Array – If this is checked, Matlab data will be 

built in structs.  Each struct is for one channel and its data is accessible using standard 
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struct access methods.  For example to get the sampling  of the first segmented channel 

you can use CSEG_001.KHz instead of CSEG_001_KHz.  Section  3.4.3 below details the 

differences when this forma is used. 

 

In addition, before the conversion starts it is possible to select what signal data channels, 

and what stream forma records go to the output file by using the menu options 

“Options/Input Definition” and “Options/Stream Format Definition” accordingly.  

 

3.4.1 Matlab Format of Signal Data Records 

The table below describes the format of the signal data records when Non Struct Mode is 

used: 

Channel 

type 

Use Variable Type Description 

Analog LFP 

NNN (001–

128) 

Data 

acquired 

  

CLFP_NNN 

 

 One Row 

 

Samples acquired  

in A/D value 

Bit 

Resolution 

CLFP_NNN_BitResolution Variable 1 A/D value 

equivalent in uV 

Gain  CLFP_ NNN_Gain Variable Total Gain of the 

specified channel  

Sampling 

Rate  

CLFP_ NNN_KHz Variable Sampling Rate in 

KHz 

Sampling 

Rate 

CLFP_ NNN_KHz_Orig Variable Sampling Rate in 

KHz (Not used) 

Time 

Acquisition 

Begin  

CLFP_ NNN_TimeBegin Variable Time of the first 

sample of the 

specified channel 

in Sec 

Time 

Acquisition 

end 

CLFP_ NNN _TimeEnd Variable Time of the last 

sample saved of the 

specified channel 

in Sec 

SEG  NNN 

(001-128) 

 

Data 

Detected 

 

CSEG_ NNN One row (Appears 

only when zero 

padding option is 

used) 

Samples detected 

in A/D value  

Bit 

Resolution 

CSEG_NNN_BitResolution Variable 1 A/D value 

equivalent in uV 

Gain  CSEG_NNN_Gain Variable Total Gain of the 

specified channel 

Sampling 

Rate  

CSEG_NNN_KHz Variable Sampling Rate in 

KHz 

Sampling 

Rate 

CSEG_001_KHz_Orig Variable Sampling Rate in 

KHz (Not used) 

Detection 

indexes 

CSEG_ NNN _LEVEL Row of indexes of 

detection in 

CSEG_NNN or in 

CSEG_NNN_LEV

EL_SEG  

Integer 
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Channel 

type 

Use Variable Type Description 

Detected 

Data 

 

CSEG_NNN_LEVEL_SEG Matrix of 96 rows 

(Appears only 

when No zero 

padding option is 

used) 

Samples detected 

in A/D value 

Sorted data 

# (1-4) 

CSEG_NNN_Template# Row of indexes of 

detection in 

CSEG_NNN or in 

CSEG_NNN_Temp

late#_SEG 

Integer 

Sorting 

indexes 

# (1-4) 

CSEG_NNN_Template#_SEG Matrix of 96 rows 

(Appears only 

when No zero 

padding option is 

used) 

Samples detected 

in A/D value 

 

Time 

Acquisition 

Begin  

CSEG_ NNN _TimeBegin Variable Time of the first 

sample of the 

specified channel 

in Sec 

Time 

Acquisition 

end 

CSEG_ NNN _TimeEnd Variable Time of the last 

sample saved of the 

specified channel 

in Sec 

Analog SPK 

NNN 

(001-128) 

Data 

acquired 

  

CSPK_ NNN  One Row 

 

Samples acquired  

in A/D value 

Bit 

Resolution 

CSPK_NNN_BitResolution Variable 1 A/D value 

equivalent in uV 

Gain  CSPK_NNN_Gain Variable Total Gain of the 

specified channel  

Sampling 

rate  

CSPK_NNN_KHz Variable Sampling Rate in 

KHz 

Sampling 

rate 

CSPK_NNN_KHz_Orig Variable Sampling Rate in 

KHz (Not used) 

Time 

Acquisition 

Begin  

CSPK_NNN_TimeBegin Variable Time of the first 

sample of the 

specified channel 

in Sec 

Time 

Acquisition 

end 

CSPK_NNN_TimeEnd Variable Time of the last 

sample saved of the 

specified channel 

in Sec 

Analog 

RAW 

NNN 

(001-128)  

Data 

acquired 

  

CRAW_NNN One Row 

 

Samples acquired 

in A/D value 

Bit 

Resolution 

CRAW_NNN_BitResolution Variable 1 A/D value 

equivalent in uV 

Gain  CRAW_NNN_Gain Variable Total Gain of the 

specified channel  

Sampling 

Rate  

CRAW_NNN_KHz Variable Sampling Rate in 

KHz 

Sampling 

Rate 

CRAW_NNN_KHz_Orig Variable Sampling Rate in 

KHz 

(Not used) 
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Channel 

type 

Use Variable Type Description 

Time 

Acquisition 

Begin  

CRAW_NNN_TimeBegin Variable Time of the first 

sample of the 

specified channel 

in Sec 

Time 

Acquisition 

end 

CRAW_NNN_TimeEnd Variable Time of the last 

sample saved of the 

specified channel 

in Sec 

Digital 

Input-TTL 

NNN 

(049-053) 

 

Timestamp 

saved when 

TTL change 

from 1 to 0 

CTTL_NNN_Down One Row of 

timestamps 

Active low time 

stamp 

Sampling 

Rate 

CTTL_NNN_KHz Variable Sampling Rate in 

KHz 

Previous 

Status 

CTTL_NNN_PrevStatus Variable The previous status 

of the TTL 

Channel (Not used) 

Sampling 

Rate 

CTTL_NNN_KHz_Orig Variable Sampling Rate in 

KHz 

(Not used) 

Time 

Acquisition 

Begin  

CTTL_NNN_TimeBegin Variable Time of first event 

in sec 

Time 

Acquisition 

end 

CTTL_NNN_TimeEnd Variable Time of last event 

in sec 

Timestamp 

saved when 

TTL change 

from 0 to 1 

CTTL_NNN_Up Row of timestamps Active high time 

stamp 

Analog 

Input  

NNN 

(001-032) 

Data 

acquired 

  

CAI_NNN One Row Samples acquired 

in A/D value 

Bit 

Resolution 

CAI_NNN_BitResolution Variable  1 A/D value 

equivalent in uV 

Gain  CAI_NNN_Gain Variable Total Gain of the 

specified channel  

Sampling 

rate  

CAI_NNN_KHz Variable Sampling Rate in 

KHz 

Sampling 

rate 

CAI_NNN_KHz_Orig Variable Sampling Rate in 

KHz 

. (Not used) 

Time 

Acquisition 

Begin  

CAI_NNN_TimeBegin Variable Time of the first 

sample of the 

specified channel 

in Sec 

Time 

Acquisition 

end 

CAI_NNN_TimeEnd Variable Time of the last 

sample saved of the 

specified channel 

in Sec 

User 

Defined 

Channel 

(001-004) 

Data 

acquired 

  

CUD_NNN One raw  Samples acquired 

in A/D value 

Bit 

Resolution 

CUD_NNN_BitResolution Variable  1 A/D value 

equivalent in uV 
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Channel 

type 

Use Variable Type Description 

Gain  CUD_NNN_Gain Variable Total Gain of the 

specified channel  

Sampling 

rate  

CUD_NNN_KHz Variable Sampling Rate in 

KHz 

Sampling 

rate 

CUD_NNN_KHz_Orig Variable Sampling Rate in 

KHz 

(Not used) 

Time 

Acquisition 

Begin  

CUD_NNN_TimeBegin Variable Time of the first 

sample of the 

specified channel 

in Sec 

Time 

Acquisition 

end 

CUD_NNN_TimeEnd Variable Time of the last 

sample saved of the 

specified channel 

in Sec 

Digital 

output port  

NNN(001-

010) 

Data 

acquired 

 

CDOUT_NNN Matrix of 2 rows 1.Timestamp 

2.Decimal value of 

the port 

Sampling 

rate 

CDOUT_NNN_KHz Variable Sampling Rate in 

KHz 

Digital 

input port 

NNN 

(001-020) 

Data 

acquired 

 

CInPort_NNN Matrix of 2 rows 1.Timestamp 

2.Decimal value of 

the port 

Sampling 

rate 

CInPort_NNN_KHz Variable Sampling Rate in 

KHz 

User Event 

port 

Data 

acquired 

 

CInPort_021 Matrix of 2 rows 1.timstamp 

2.Event ID 

Sampling 

rate 

CInPort_021_KHz Variable  Sampling Rate in 

KHz 

Stim marker  

NNN 

(001-004) 

Data 

acquired 

 

CStimMarker_NNN Matrix of 2 rows 1.Timestamp 

2.ID of the channel 

stimulated  

Sampling 

rate 

CStimMarker_NNN_KHz Variable Sampling rate in 

KHz 

     

 

3.4.2 Matlab Format of Stream Data Records 

 

The table below describes the format of the stream data records detailed in section ‎3.3 

above.   

 

ID Use Variables Type Description 

1 Channel 

Acquisition on/off 

SF_ACQ_ON_OFF_KHz Variable Sampling Rate in KHz 

SF_ACQ_ON_OFF Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. 0/1  

4. Source ID 
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ID Use Variables Type Description 

2 Sampling Rate 

Divider 

SF_SR_DOWN_SAMP_KHz Variable Sampling Rate in KHz 

SF_ SR_DOWN_SAMP Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Down sample factor 

4. Source ID 

3 Detection level line 

value 

SF_LEVEL_KHz Variable Sampling Rate in KHz 

SF_LEVEL Matrix of 

5 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Value is A/D value  

4. Slope (1=down, 2=up) 

5. Source ID 

4 Filtering 

parameters 

 

SF_FILTER_KHz Variable Sampling Rate in KHz 

SF_FILTER Matrix of 

5 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Low Pass (HW/Value in Hz)  

4. High Pass (HW/Value in Hz)  

5. Source ID 

5 Reference 

electrode 

SF_REF_ELEC_KHz Variable Sampling Rate in KHz 

SF_REF_ELEC Matrix of 

5 rows 

1. Time stamp in sample number 

2. Channel ID of Referenced 

Electrode 

3. Channel ID of Reference 

Electrode (0=no reference 

defined) 

4. Active – 0/1  

5. Source ID 

100 Online sorting 

template definition 

SF_TEMP_VALUE_KHz Variable Sampling Rate in KHz 

SF_TEMP_VALUE Matrix of 

21 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Template Number 

4. Number of template points 

5. Template point position index 

and value in A/D value – 8 

pairs 

6. Source ID 

101 Template detection SF_TEMP_THRESH_KHz Variable Sampling Rate in KHz 
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ID Use Variables Type Description 

threshold and noise 

values 

SF_TEMP_THRESH Matrix of 

6 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Template number 

4. Detection Threshold 

5. Noise Threshold 

6. Source ID 

102 Template detection 

is on/off 

SF_TEMP_ON_OFF_KHz Variable Sampling Rate in KHz 

SF_TEMP_ON_OFF Matrix of 

5 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Template Number 

4. Active – 0/1  

5. Source ID 

103 Template Window 

discriminator 

(Include) definition 

SF_TEMP_INC_KHz Variable Sampling Rate in KHz 

SF_TEMP_INC Matrix of 

9 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Template Number 

4. Discriminator Number 

5. Active – 0/1 

6. Position Index  

7. Bottom (A/D Value) 

8. Top (A/D Value) 

9. Source ID 

150 Text Message from 

GUI 

SF_TEXT_MSG_KHz Variable Sampling Rate in KHz 

SF_TEXT_MSG Matrix of 

N rows 

(N=Num

ber of 

letters + 

2) 

1. Time stamp in sample number 

2. First letter in ASCII of text 

3. Second letter in ASCII of Text 

4. . 

5. . 

6. (N-1)th letter in ASCII of Text  

7. Source ID 

151 Print message from 

Script 

SF_PRINT_MSG_KHz Variable Sampling Rate in KHz 

SF_PRINT_MSG Matrix of 

3 rows 

1. Time stamp in sample number 

2. Print Message 

3. Source ID 

200 Contact type SF_CONTACT_TYPE_KHz Variable Sampling Rate in KHz 
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ID Use Variables Type Description 

SF_CONTACT_TYPE Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Contact Type 

4. Source ID 

201 Headstage gain SF_HS_GAIN_KHz Variable Sampling Rate in KHz 

SF_HS_GAIN Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. HeadStage Gain 

4. Source ID 

202 PreAmp Settings SF_PRE_GAIN_KHz Variable Sampling Rate in KHz 

SF_PRE_GAIN Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. PreAmp Gain (0=No Preamp) 

4. Source ID 

203 Impedance sine 

wave values 

SF_IMP_WAVE_KHz Variable Sampling Rate in KHz 

SF_IMP_WAVE Matrix of 

5 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Sine Wave Amplitude (mV) 

4. Frequency  

5. Source ID 

204 Impedance value 

measured 

SF_IMP_VALUE_KHz Variable Sampling Rate in KHz 

SF_IMP_VALUE Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Impedance Value in  KOhm 

4. Source ID 

205 Electrode 

grounding 

SF_ELEC_GROUND_KHz Variable Sampling Rate in KHz 

SF_ELEC_GROUND Matrix of 

4 rows 

1. Time stamp in sample number 

2. Channel ID 

3. 0/1 (1=Grounded) 

4. Source ID 

206 Electrode position SF_ELEC_POSITION_KHz Variable Sampling Rate in KHz 
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ID Use Variables Type Description 

reported by the 

EPS software  

SF_ELEC_POSITION Matrix of 

5 rows 

1. Time stamp in sample number 

2. Channel ID 

3. Board Index 

4. Electrode Index 

5. Absolute Depth (mm) 

6. Relative Depth (mm) 

7. Source ID 

250 Animal Position 

reported by 

EthoVision 

(Noldus) 

SF_EV_ANIM_POS_KHz Variable Sampling Rate in KHz 

SF_EV_ANIM_POS Matrix of 

19 rows 

1. Time stamp in sample number 

2. Arena Number 

3. Subject Number 

4. Trial Number 

5. Frame Number 

6. Number of missing frames 

7. COG Tracking Valid (0=not 

valid, 1=valid 

8. Center of Gravity X 

9. Center of Gravity Y 

10. Center of Gravity Z 

11. Nose Tracking Valid (0=not 

valid, 1=valid 

12. Nose X (0 if not tracked) 

13. Nose Y (0 if not tracked) 

14. Nose Z (0 if not tracked) 

15. Tail Tracking Valid (0=not 

valid, 1=valid 

16. Tail X (0 if not tracked) 

17. Tail Y (0 if not tracked) 

18. Tail Z (0 if not tracked) 

19. Source ID 

251 Video Frame 

information 

reported by Norpix 

SF_NORPIX_FRAME_KHz Variable Sampling Rate in KHz 

SF_NORPIX_FRAME Matrix of 

4 rows 

1. Time stamp in sample number 

2. Frame Number 

3. Relative Time 

4. Source ID 

 

The Source ID on all the commands indicate who initiated the command, as follows: 

01 – Internally initiated by the DSP 
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03 – One of the GUI users 

04 – One of the Matlab or C users 

 

3.4.3 Signal Data Format when Struct Mode is used 

 

As stated above there is an option to build the Matlab tables in struct format, so filed are 

accessible using the standard struct access methods.   When this mode is used a few 

additional things will appear in the converted data as follows:   

1. The channel samples will be in StructName.Samples. 

2. A channel ID struct variable was added to all records when applicable. 

3. Any struct field that does not have data wil be filled with “NAN”. 

4. A Struct Array that maps channel ID’s to channel names was added.  It is called 

“Channel_ID_Name_Map”. 

Field Names in this struct are 

 ID 

 Name 

5. A Struct Array that maps Ports ID’s to port names was added.  It is called 

“Ports_ID_Name_Map”. 

Field Names in this struct are 

 ID 

 Name 

To make things more clear here is an example of non-struct and struct mode formats 

If non-struct format had the following fileds: 

  

CLFP_001 

CLFP_001_BitResultion 

CLFP_001_Gain 

CLFP_001_KHz 

CLFP_001_KHz_Orig 

CLFP_001_TimeBegin 

CLFP_001_TimeEnd 

 

In the struct format data will be combined under one struct called 

CLFP_001 and fileds are accessible as follows: 

 

CLFP_001.ID 

CLFP_001.Samples 

CLFP_001.BitResultion 
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CLFP_001.Gain 

CLFP_001.KHz 

CLFP_001.KHz_Orig 

CLFP_001.TimeBegin 

CLFP_001.TimeEnd 

 

 

3.4.4 Stream Data Format when Struct Mode is used 

 

When Struct Mode is used, each type of Stream Data is formatted in a matrix of arrays. 

Each occurance contains all relevant information for that struct type as shown in the table 

below.  The sampling rate for all Stream format records in a variable names 

SF_Sampling_Rate. 

 

ID Use Struct Array Name Fields of struct Notes 

1 Channel 

Acquisition on/off 

SF_ACQ_ON TimeStamp  

ChannelID  

State 1 = on 

SourceID  

2 Sampling Rate 

Divider 

SF_ SR_DOWN_SAMP TimeStamp  

ChannelID  

Factor  

SourceID  

3 Detection level line 

value 

SF_LEVEL TimeStamp  

ChannelID  

LevelLineValue A/D value  

LevelLineDirection 1=down, 2=up 

SourceID  

4 Filtering 

parameters 

 

SF_FILTER TimeStamp  

ChannelID  

LowPass Hz 

HighPass Hz 

SourceID  

5 Reference 

electrode 

SF_REF_ELEC TimeStamp  

ChannelID  

RefChannelID  
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ID Use Struct Array Name Fields of struct Notes 

Enabled 1=Enabled 

SourceID  

100 Online sorting 

template definition 

SF_TEMP_VALUE TimeStamp  

ChannelID  

TemplateNumber 1,2,3,4 

TemplatePointsCount  

TempPointPosition_i i=0,1,….,7 

TempPointAmplitude_i A/D value 

i=0,1,….,7 

SourceID  

101 Template detection 

threshold and noise 

values 

SF_TEMP_THRESH TimeStamp  

ChannelID  

TemplateNumber  

ThresholdValue  

NoiseLevelValue  

SourceID  

102 Template detection 

is on/off 

SF_TEMP_ON TimeStamp  

ChannelID  

TemplateNumber  

State  

SourceID  

103 Template Window 

discriminator 

(Include) definition 

SF_TEMP_INC TimeStamp  

ChannelID  

TemplateNumber 1,2,3,4 

IncludeBarNumber 1,2,3 

Enabled 1=Enabled 

SampleIdx  

BottomADValue A/D Value 

TopADValue A/D Value 

SourceID  

150 Text Message from 

GUI 

SF_TEXT_MSG TimeStamp  

Message  

SourceID  

151 Print message from SF_PRINT_MSG TimeStamp  
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ID Use Struct Array Name Fields of struct Notes 

Script Value  

SourceID  

200 Contact type SF_CONTACT_TYPE TimeStamp  

ChannelID  

ContactType  

SourceID  

201 Headstage gain SF_HS_GAIN TimeStamp  

ChannelID  

Gain  

SourceID  

202 PreAmp Settings SF_PRE_GAIN TimeStamp  

ChannelID  

Gain 0=No 

Preamp 

SourceID  

203 Impedance sine 

wave values 

SF_IMP_WAVE TimeStamp  

ChannelID  

Amp mV 

Freq Hz 

SourceID  

204 Impedance value 

measured 

SF_IMP_VALUE TimeStamp  

ChannelID  

Impedance KOhm 

SourceID  

205 Electrode 

grounding 

SF_ELEC_GROUND TimeStamp  

ChannelID  

Enabled 1=Enabled 

SourceID  

206 Electrode position 

reported by the 

EPS software  

SF_ELEC_POSITION TimeStamp  

ChannelID  

BoardIdx  

ElectIdx  

AbsDepth mm 

RelDepth mm 
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ID Use Struct Array Name Fields of struct Notes 

SourceID  

250 Animal Position 

reported by 

EthoVision 

(Noldus) 

SF_EV_ANIM_POS 
TimeStamp 

 

Arena 
Arena Number 

Subject 

Subject 

Number 

Trial 
 

Frame  

MissingFrame  

Cog_Valid 1=valid 

Cog_X  

Cog_Y  

Cog_Z  

Nose_Vaild 

 

1=valid 

Nose_X  

Nose_Y  

Nose_Z  

Tail_Vaild 1=valid 

Tail_X  

Tail_Y  

Tail_Z  

SourceID Source ID 

251 Video Frame 

information 

reported by Norpix 

SF_NORPIX_FRAME TimeStamp  

FrameNumber  

RelativeTime  

SourceID  

 

3.5 Convert a Matlab File to Map Format 

When selecting a Matlab file for conversion, the following window appears: 

 

Figure 15: Matlab to Map Conversion 
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Click OK to proceed with conversion. The “Save As” dialog appears in which the user 

needs to set the output file name and path. 

After setting the name and location of the saved file and pressing “Save”, the following 

window appears: 

 

Figure 16: Matlab File Dialog 

Depending on the size of the file, the conversion process may take several minutes. 

After loading the file, channel information will be available on the window. When 

conversion is done, the new map file will be opened. 

3.6 Convert a Binary File to Text Format 

The ‘Convert All’ menu item converts all loaded files. When selected, the “Convert All” 

option displays the ‘Browse For Folder’ dialog box (see Figure 17). Here, the target 

directory for the converted output files may be set. The conversion process starts when 

the “OK” button is clicked. The resulting file names remain the same as the source files, 

but the extensions changes to “*.txt”. 
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Figure 17: Browse For Folder Dialog Window 

The “Convert (list)” menu item displays the ‘Select files for conversion’ dialog box (see 

Figure 18). This dialog box displays the list of all loaded binary files. After making a 

selection and clicking the ‘Ok’ button, the dialog box ‘Choose directory’ appears (see 

Figure 17) and works in the same manner as above. 

 

Figure 18: Select files for conversion 

The “Convert to text and Save As…” is used to convert only the active binary file. 

When selected, it displays the standard Save File dialog box, which allows setting the 

name and directory of the output file (See Figure 19). When ready, click the “Save” 

button and the conversion will begin. 
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Figure 19: ‘Save As’ dialog box for text files 

The progress of the conversion and the name of the output file are shown in the Status 

Bar of each Binary File Window. It is possible to save more than one file simultaneously. 

Every time a conversion process is completed, successfully or unsuccessfully, the dialog 

box “File creating report” appears (see Figure 20). This box shows all the file activities 

for the current session. Exiting the current conversion session clears the list automatically. 

To clear the list manually, click the appropriate button in the “File creating report” 

dialog box 

 

Figure 20: File creating report 

For better performance, you must not activate this dialog while the conversion is in 

progress (the caption must be gray). 
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3.7 Convert a Binary File to Matrix Format 

Before starting conversion to matrix file format, setting the matrix file creation options 

may be required. For this purpose, select the “Create Options” item from the “Options” 

menu. The ‘Options’ dialog appears (see Figure 21). 

 

Figure 21: Text file options 

Creating a text matrix file is a two-step process: 

1. The binary map file is converted to a binary matrix file 

2. The resulting binary matrix file is, in turn, converted to a text matrix file. 

These two steps may be done separately by running the “Save to binary matrix…” item 

in the “File” menu, and then running the “Matrix to text…” item in the same menu. To 

convert a file directly from a binary map format to a text matrix format, select the “From 

Map to Matrix text” item, which runs both steps sequentially. 

The “Convert All” and “Convert (list)” items for matrix files have the same function as 

the ones for the plain text file conversion. They both do the complete two-step conversion 

process for all/selected files. The binary matrix files are saved with the same name as the 

source file, but the extension changes to “.mtc”. The text matrix files are also saved with 

the same name as the source file, but the first character in the name changes to the letter 

‘m’ and the extension changes to “.txt”. 

The first several rows of the text matrix file belong to the header. The remaining rows 

contain data and are called ‘data rows’. Each data row consists of cells, one for each 

channel. Each cell contains one sample. If the sample of a particular channel is absent, its 

cell will contain the string ‘-------’. The number of data rows inside the file equals to the 

timestamp of the fastest channel. 

3.8 Convert a Map File to Plx Format 

To convert AlphaMap files to Plexon data files, select Open from the Map Converter 

application. The “Open” dialog appears. Select the required map file and click ‘Open’. 

After the file is opened, select File->Convert to Plexon data files. The ‘Browse For 

Folder’ dialog appears (Figure 17). Select a target directory for saving the new file. 
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Before starting conversion to Plx file format, setting the file creation options may be 

required to define which port will be handled as a strobed port in Plexon Offline sorter. 

For this purpose, select the “Create Options” item from the “Options” menu. The 

‘Options’ dialog appears (see Figure 21). 

In the Plexon compatibility portion, select which port will be treated as the strobed port.  

After the conversion is complete, a ‘File creating report’ window opens: 

 

Figure 22: ‘File creating report’ dialog 

A file with the same name, but with a “.plx” extension, is created in the specified 

directory. 

Click the ‘Close’ button to close the window. 

3.8.1 Interrupting the Conversion Process 

The program shows the progress of the conversion (Figure 23). 
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Figure 23: Conversion process display 

To interrupt the conversion process, close the Binary File Window or the application 

itself.  

 

 

3.9 Batch Mode for Conversion 

Conversion may be run in batch mode. Set the batch conversion options and then run 

conversion in the batch mode. 

3.9.1 Batch Mode Definition 

For the batch mode definition, select the item ‘Batch mode options’ from menu 

‘Options’ or click the button  on the tool bar. The dialog “Batch mode options” 

appears (Figure 24). 

 

Figure 24: Batch mode options dialog 
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Click the ‘Add file(s)’ button. The dialog box “Select source files” appears (Figure 25). 

 

Figure 25: Select source files dialog 

Select desired files and click ‘OK’. The selected file names are added to the list of the 

source files (Figure 26) 

 

Figure 26: List of source files in the ‘Batch mode options’ Dialog 

If the word ‘Yes’ is written in the cell of the ‘Text’, ‘Matrix’ or ‘Matlab’ columns, the 

source file will be converted to the ‘Text’, ‘Matrix’ and/or ‘Matlab’ format accordingly. 

To change the contents of any cell, double click on this cell or select desired rows and 

click the appropriate button (‘Yes “Text”’, ‘No “Text”’, ‘Yes “Matrix”’, ‘No 

“Matrix”’, ‘Yes “Matlab”’, ‘No “Matlab”’). 
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It is possible to select only a sub-set of analog and/or digital channels for conversion by 

filling in the analog and/or digital pins edit boxes on the right side of window that is 

shown in Figure 26. If these boxes are left empty, data for all channels will be converted 

and written to the output file. 

The button “Select folder” allows setting your output target directory (see Figure 27). 

Choose the desired folder and click the button ‘OK’. The name of the selected folder 

appears inside the ‘Target folder:’ box. 

 

Figure 27: Browse For Folder dialog 

To save the defined set of the options in a “.ini” file, click the button ‘Save options to 

file’. The window appears: 

 

Figure 28: Batch Options Save As dialog 

Select the desired folder, type a file name and click “Save”. 
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To retrieve saved options, click the ‘Read options from file’ button. Select a file and 

click on “Open”. If the list of source files is not empty, the message box shown in Figure 

29 appears while the list is being updated. 

 
 

Figure 29: Updating the list of source files 

Click the “Yes” button if you want to add the saved list to the current list, or “No” if you 

want to replace it. 

3.9.2 Running Conversion in Batch Mode 

To run conversion in batch mode, select the item ‘Run conversion in the batch mode’ 

from the ‘File’ menu or click the  button on the tool bar. Before running the actual 

conversion, check the input data by selecting the item ‘Validate conversion in the batch 

mode’ from the ‘File’ menu or clicking the  button on the tool bar. 

When the conversion is completed, the “File creation report” appears showing various 

file activities. The system also writes the conversion results into the file ‘convert.log’ in 

the defined target directory. 

3.10 Running Mapfile from a Command Line 

It is possible to run the Mapfile converter from a command line.  This will allow you to 

run a batch file to convert file.   

To run the Mapfile from a Windows command line use the following format:  

mapfile |FileName|OutputFormat|OutputFolder|ChannelList| 

 

To run the Mapfile from a DOS command line use the following format:  

 
mapfile =FileName=OutputFormat=OutputFolder=ChannelList= 

  

FileName:   Specify the name of the file or files you would like to convert.  It is 

possible to specify a.lsm, a .map file, or a list of files.   Files names should be 

specified with a full path name.  Below are some examples: 

 
c:\temp\files.lsm         for one lsm file 
c:\temp\file1.map        for one map file 
c:\temp\file1.map#c:\temp\file2.map#c:\temp\file3.map     for list of map file 
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OutputFormat:  Specify the format of the output files as follows: 

 
Text  Convert to text 
Matlab  Convert to matlab 
TxtMatlab  Convert to text that is compatible with matlab 
 

  

OutputFolder:  Specify the full path name of the output folder as follows: 

 
c:\outputfolder 

  

ChannelList:  If you would like to convert all channels, there is not need to use this 

parameter.  If you would like to convert part of the channels, specify a list of channel 

ID’s that you would like convert.  Below are some examples: 

 
10001,10002,10004,10005  Convert only channels specified in the list 
10001-10004  Convert the specified range of channels 
10001-10004, 10008-10012  Convert the specified ranges of channels 

 

Note:  If you are not going to specify a list of channels, you must include the last “|” 

or “=” that follows the output folder in the command line.   
 

Below is an example of a full command running from a DOS command line that 

includes a channel list: 

 
mapfile.exe =c:\temp\file1.map=Text=c:\output=10001-10004,10010-10014= 

 

Below is an example of a full command running from a DOS command line that does 

not include a channel list: 

 
mapfile.exe =c:\temp\file1.map=Text=c:\output= 

 

3.11 Output Text File Structure 

Each text file consists of different lines with a special structure in which the properties 

and data of the signal (sample) blocks (objects) are presented. The type of a line is 

defined in its key word. Spaces and tabulators separate the fields within a line. Following 

is the line structure. 

Tip: You may find that all info and erase rows begin with the ‘%’ sign and in the data 

rows words like ‘contin’, ‘level’, etc are missing. It depends on the setting options 

in the ‘Text file options‘ dialog (see Figure 21). 

The file lines contain: 

3.11.1 Properties: 

Info Level 10001 3.906 754 

Info Contin 10014 62.500 200 

Info Digital 11003 62.50 3 
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3.11.2 Data: 

Each data line contains a header and a data (block samples are represented by the decimal 

equivalent of 16-bit signed binary numbers). 

3.11.2.1.1 For a Channel in Continuous Mode 

For a channel in continuous mode the header contains: 

Contin 10015 20 

 

3.11.2.1.2 For a Channel in Level Mode 

For a channel in Level mode the header contains: 

Level 10001 10 10 1440 2161 

 

3.11.2.1.3 For a channel in External Trigger mode 

For a channel in External Trigger mode the header contains: 

ExtTrg 10001 10 40 2161 

 

3.11.2.1.4 For a Digital Channel Trigger 

For a Digital Channel Trigger the header contains: 

Digital 11003 0 40 

 

3.11.2.1.5 Erase Information: 

Erase 10007 1179 1243 

Erase Board=1 Digital port=0 1179 1243 
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Figure 30: Text File Contents 

3.12 Matrix Text File Structure 

Each matrix text file contains header and data rows. Separators between the fields in a 

row are spaces and tabulators. Header rows contain date and time for the beginning of 

acquisition, number of channels and sampling rates. The number of data rows in the file 

equals to the timestamp of the fastest channel (see Figure 31). Data rows contain samples. 

For channels in the Level or External Trigger mode, the first sample from the post trigger 

is followed by the character ‘!’. 
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Figure 31: Sample of matrix text file contents 
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4 POST PROCESSING  

The post-processing module enables the user to pass over the recorded map files applying 

data reduction, conversion, and online to offline tagging, as needed. 

The post processing stage segments the data according to a detection algorithm keeping 

only the waveforms. This newly segmented data channel is compared against the online 

sorting and tagging each waveform with the appropriate online class. 

The output of this stage can be one of the following file formats: 

 ALPHA OMEGA - .map 

 CED - .smr 

 PLEXON - .plx 

The data acquisition system (AlphaLab or AlphaMap) is able to save the continuous raw 

data for each channel and simultaneously save the real time sorting events. While the user 

can select the resulting file and continue with it to the AlphaSort (Alpha Omega Offline 

Sorting), for other offline sorters, such as Plexon Offline Sorter, the user needs to 

segment the continuous channel into waveform segments tagging each segment with a 

matching real time class. 

Because segmentation is done offline, the user can be sure that no waveform or potential 

spike is lost due to a wrong threshold during the recording session. 

The following are all the functions that can be done using the Post Processing: 

 Perform file conversion 

 Select a subset of channels 

 Rename channels 

 Perform continuous channel segmentation 

Perform tagging of online detections to segmented data 

To open the Post Processing main window, select “File  Post Processing …”.   

The window has 5 panels, which will be discussed later on: (See Figure 32 below) 

 Source  

 Workspace file 

 Target  

 Statistics 

 Segmentation option  
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4.1 The main Post Processing Window 

 

Figure 32: File Post Processing Main window  

 

4.1.1 Source 

Folder: 

Browse to the directory where your files are located 
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Lsm: 

Select the desired lsm file.  If at the time that you select an lsm file there was a 

configuration file name specified in the Workspace area, and the selected 

configuration file is not compatible with the lsm file selected, the message shown in 

Figure 33 appears, and the Workspace file name is cleared allowing you to either 

browse for and select an existing configuration file that is compatible with the lsm file, 

or to create a new configuration file. 

 

Figure 33: Invalid Configuration File Message 

Map files: 

The name of the map file(s) listed inside the specified “.lsm” file automatically 

appears in this field. 

4.1.2 Workspace File 

Name: 

Specify the name of a conversion options file, or browse to the directory where it is 

located.  This workspace will save all your selected options and settings for further 

usage in the future. Hence you don’t have to set all the parameters next time. 

If no file is selected (name filed is empty, you can either browse and open an existing 

file or you can start a the definition of a new configuration file (Workspace). To Start a 

new Workspace: Click on “Edit template” button. If no file was already selected, the 

message in Figure 34 will appear. Click “OK” and move to the next step to name and 

save your new Workspace.  This process is explained further down.  

Note:  the Workspace files format is “*.ini” 

 

Figure 34: Warning Message - Wrong Conversion Option 

Load Mapping Defaults: 

Clicking this button loads the mapping defaults.  Mapping defaults refers to mapping 

the real time detections to specific continuous analog channels.    See Event channel 
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mapping column in the “Workspace Configurations” window shown in Figure 37 

below. 

Edit Template: 

Clicking this button opens the “Workspace Configurations” window (Figure 37): (Or 

to start a new Workspace as described above). This option will be discussed further on. 

4.1.3 Target 

Folder: 

Browse to the destination directory where your output file should be saved. 

Save Options Checkboxes: 

Select one or more output formats by clicking one or more of the following available 

check boxes: 

 Save as map format. 

 Save as plx format. 

 Save as smr format. 

When plx format is selected, specify which digital port should be marked as a 

strobed port for Plexon Offline software. 

4.1.4 Statistics 

Channel: 

Select the desired channel from the drop-down menu list you wish to observe while 

processing is being executed.   Every time post processing is started, and the 

segmentation and tagging option is activated, Post Processing generates statistical data 

for each channel showing how many spikes were detected, how many matched each of 

the Online class specified, and how many additional possible spike may be processed 

in addition to what was detected in real time.    The information shown here is not 

saved anywhere, and will be erased when Post Processing is closed or started on a 

different file.   Figure 35 show an example of statistical data foe a channel. 
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Figure 35: Tagging Statistical Data 

4.1.5 Segmentation Options 

The list of channels under the “Segmentation Options” is populated with continuous 

channels that have a name specified in the “Segmented name” column in the 

“Workspace Configurations” window. 

Checkbox: 

Click inside the checkbox to specify which channel out of the list you wish to do 

segmentation on.   This  

Name: 

Name of continuous channel as it appears in the “Workspace Configurations” 

window under the “New name” column.  

Segmented Name: 

Name of the segmented channel in the output file. This name cane be altered also 

in the “Workspace Configurations” Window 

Type: 

Type of channel.  This will always be continuous. 

Sampling Rate: 

The Sampling rate of the channel. 

Properties Button: 

Select one or more of the displayed channels then click the Properties button. The 

“Channel Properties” window opens. See Figure 36.  Fields in this window are 

explained in section  4.2 below. 

Start and Cancel buttons: 

To start post processing press the Start button, and to cancel at any time press 

Cancel. 
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4.2 Channel Segmentation Properties 

The channel segmentation properties window allows you to define how the segmentation 

and tagging for each channel will be done.    There are two ways to segment data; one is 

simply to extract spike segments by using the online sorting classifications and detection 

timestamps, and the other is by extracting segments using a RMS multiplier and if 

possible tags them to online detections.  The figure below shows both options and all their 

paramenters. 

 
 

Figure 36: Channel Properties Window 

4.2.1 Segmentation according to online detections 

Under this option you will only tell the system how much data to extract and where to 

begin and end each segment.   

   

Segment Length: 

Here you have to specify how long you would like each segment to be in 

milliseconds.  

Segment Start: 

Here you have to specify for each online detection, where would like your segment to 

start in relation to the online detection time stamp.   Alpha Omega’s online sorter, the 

Alpha Spike Detector (ASD), is capable of isolating up to 3 units or waveform shapes 

and this is what the T1, T2, T3 refer to.  

Keep Overlapping Spikes: 
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If this check box is not checked, the system will throw way segments that overlap 

with other segments prior to them that have the same classification.  

 

4.2.2 Segmentation according to RMS 

Under this option you will tell the system what threshold to use, how much data to extract 

when the threshold is crossed, and how to match online detection classes to the segments.   

 

Segment Duration: 

In this section you will be able to define how much data to extract when the threshold 

is crossed.  You will specify how much time before the crossing and how much time 

after.  

o Pre Time [mSec]: Time before crossing the threshold 

o Post Time [mSec]: Time after crossing the threshold 

The total of the Pre and Post times will be the duration of the spike saved to the output 

file.   

Detection Parameters: 

In this section you will be able to define the threshold that will be used to extract the 

spike. The threshold is set by the means of a multiplier of an RMS level for a certain 

specified time.  

RMS Factor: The multiplier of the RMS level that will be used as a threshold. 

Test Time [mSec]: Total test time that will be used to calculate the RMS level 

in mSec. 

Dead Time [mSec]: Minimum time between consecutive detections. 

Online to Offline Matching Parameters: 

Shift channels timestamps by [+/- mSec]: Used to synchronize detected data 

segments to online detection times.  After shifting the time stamp of each 

detected segment by the specified shift time, it is compared with the online 

detections, and if it is within 0.5 mSec from any of the online detection, this 

segment is tagged accordingly.  The time stamp of the segment is the RMS 

threshold crossing time.   

Load Default Values: Load the current default settings 

Set As Default: Set the current settings as default settings for all channels 

Cancel: Click to quit without making changes to current settings 

OK: Click to confirm your settings 
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4.3 Workspace Configurations 

The “Workspace Configurations” window allows the user to define a channel subset for 

conversion, another set for segmentation, the mapping of online detections, and finally it 

allows renaming channels. 

To access the “Workspace Configuration” window shown in Figure 37, click on the “Edit 

template” Button. 

The window is divided into 3 major panes, and a set of buttons.  The panes are: 

1. Continuous channels pane 

2. Segmented channels pane 

3. Event channels pane 

 

Figure 37: Workspace Configurations Window 

Before we discuss the 3 panes, we will first explain the buttons: 
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Open – Open a configurations file 

Save As – Save the opened configurations file under a new name 

Save – Save the opened configurations file 

Properties – Select any one or a group of consecutive channels from any one of the 3 

panes and press the Properties button to make changes. It is also possible to open the 

properties window of any channel by double clicking on it.  Figure 38, Figure 39, and 

Figure 40 below show the properties windows of the continuous, segmented, and 

event channel respectively. 

The “Pass information of unselected channels” check box under the Continuous and the 

Segmented channel lists, says that the headers of the unselected channels should be passed to 

the output file.    

 

Figure 38: Continuous Channel Properties window 

 

 

Figure 39: Segmented Channel Properties window 
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Figure 40: Event Channel Properties window 

 

Allowable changes are explained for each type of channels below.    

OK – Save changes to the opened configurations file and exit 

Cancel – Exit without saving changes after the last save 

 

Channels Panes  

In all 3 panes the following options exist: 

Check Box – This box is used to select/unselect the channel to be converted and 

written to the output file.  It is possible to select several channels and click on one of 

the check boxes of the selected channels to select/unselect them all.  

Selecting/unselecting channels can alternatively be done from the continuous channel 

properties window using the “Convert and save” check box.   

Original name – This filed shows the channel’s name as it exists in the file.  This is 

an informational field and cannot be changed. 

New name – This filed indicates what the channel’s name will be when it written to 

the output files.   By defaults it is set to the Original name. This field can be changed 

only through the properties window.  If several fields are selected and a new name is 

given, all selected channels’ “New name” will be changed to the new name entered, 

and appended with “_n”, where n is a sequential number starting at 1.  

Sampling Rate – This filed shows the channel’s sampling rate as it exists in the file.  

This is an informational field and cannot be changed. 

 

In addition to the above fields certain panes have additional fields as follows: 

Additional fields in the Continuous channels Pane 
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Segmented name – This filed has two functions as follows: 

1. Its existence dictates that this channel will be available for segmentation and will 

appear in the “Segmentation Options” list shown in Figure 32 above.  Deciding 

if it will be segmented or not will be done by checking the check box in that list. 

2. It will specify what the segmented channel name will be in the output file if it was 

selected for segmentation. 

By defaults this field is set to the Original name appended with “_s”.  This field can 

be changed only through the properties window.  If several fields are selected and a 

new name is given, all selected channels’ “Segmented name” will be changed to the 

name entered, and appended with “_n”, where n is a sequential number starting at 1.  

 

Additional fields in the Events channels Pane 

 

Mapping – This filed is used to map online detection channels to continuous 

channels. This information will be used to tag the segments extracted from the 

continuous signal with the online detections for that channels.   

Form example, under the AlphaLab system, the continuous signal of channel number 

one is recorded in the Acquisition system with a channel name of SPK1. The Real 

Time Sorting system also sorts channel number 1 and sends the online detection times 

to the Acquisition system, up to 4 classes (3 templates and one level), and the 

Acquisition system logs these event channels under the names SPK1_T1, SPK1_T2, 

SPK1_T3, and SPK1_L.  For the Post Processing to be able to do the correct tagging 

it is necessary for us to tell it that SPK1_T1, SPK1_T2, SPK1_T3, and SPK1_L are 

the detections for the continuous channel SPK1, and this is exactly what Mapping 

comes to do.  

To change the Mapping field for a specific channel select the channel with a single 

click, and then click on the mapping field for that channel.  This second click will 

reveal a drop down list button on the mapping field.  When this drop down button is 

clicked it will show a list of continuous channels available for selection.  Select one of 

them by clicking on it.  It is also possible to select several channels first and then click 

on the Mapping field of one of the selected channels to reveal the drop down button 

and select the continuous channel for all the selected event channels.   This is exactly 

what is shown in Figure 41 below. 

 

Alternatively, for files that were recorded using the AlphaLab system with standard 

settings, it is possible to simply press the “Load Mapping Defaults” button shown in 

Figure 32 under the “Workspace file” section of the main Post Processing window.  

Pressing this button before clicking the “Edit Template” button to go into the 

“Workspace Configurations” window will set all the mapping fields of the Event 

channels according to the default AlphaLab setting.   
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Figure 41: Event Channel Mapping 
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5 FILE MERGING 

File merging allows the user to: 

 Merge a “*.lsm” file with one or more “*.lsm” files 

 Merge a “*.map” file with one or more “*.map” files 

Merge any number of “*.lsm” files with any number of “*.map” files 

The user can also specify the order of the merging process, the name and location of the 

output files, the size and time limits on each of the output files, and finally how the files 

will be merged; in parallel or consecutively.   When  “.lsm” files is selected for merging, 

the map files within the “.lsm” file are treated as one file. 

 

5.1 Starting the Merging utility  

To start the Merging utility, from the main Map Converter interface, Click “File / 

Merging …”, and the “Merging” window shown in Figure 42 opens.  The Merging 

window has two main panes, “Input files” and  “Output files”.  These two panes are 

explained below. 

 

Figure 42: File Merging Main Window 

 

 

5.2 Merging window buttons 

Before we explain the different panes, we will first explain the buttons available in the 

Merging interface outside of the two main panes.   
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Start – Start the merging process.  When ready to perform the merge, click the Start 

button. Once the merge process starts, the following will occur: 

1. The scanning process starts and the “Start” button is replaced with a 

“Stop” button. 

2. The message “Scanning…”‎ appears below the progress bar (See 

Figure 43). 

 

Figure 43: Scanning process 

3. Once the scanning process is complete, the merge process starts, the 

name of the output file appears below the progress bar, and the 

progress bar shows the progress of the merge process (See Figure 44). 

 

Figure 44: Merging process 

 

Cancel – Close the merging window.  If merging is started this button becomes 

inactive. 

 

5.3 Merging window panes 

As mentioned above the merging window contains 3 main panes.  These panes are 

explained below. 

5.3.1 Input files Pane  

In the “Input files” pane has two sections; the Files Selection section and the Files for 

merging section.  The Files Selection section allows you see the contents of one folder at 

a time, and once the list of files is displayed, you will be able to move some or all the files 

to the Files for merging section for merging. 

The following is a list of the buttons available within the Input files pane  
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>> – Select all files listed in “File selection” list on the left side for merging and pass 

them to the “Files for merging list” on the right side. 

> – Select the highlighted file or files from the “File selection” list on the left side for 

merging and pass them to the “Files for merging” list on the right side. 

< – Remove the highlighted file or files from the “Files for merging” list on the right 

side. 

<< – Remove all files from the “Files for merging” list on the right side 

 

5.3.1.1 Files Selection 

Lsm/Map” - click the radio button for the type of files you wish to see in the Name 

list – “.lsm” only, “.map” only or both.  To explain how this works let us take an 

example: 

A certain folder selected in the Folder field contains map file and lsm files 

as follows: 

i2401001.lsm in which the following map files are included 

A2401001.map 

A2401002.map 

A2401003.map 

A2401004.map 

A2401005.map 

i2401006.lsm in which the following map files are included 

A2401006.map 

A2401007.map 

Two additional map file that do not have an lsm file 

A2401006Post.map 

A2401007Post.map 

Figure 45 below shows how the name list changes when each of 

the radio buttons is selected.  In short, the first two options are self 

explanatory, and the third option, Lsm & Map files lists all the lsm 

files, only the map files that do not belong to any lsm files. 
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Figure 45: File type selection 

 

Folder - Specify the folder where files are located 

Name – A list of files in the selected folder. Select one or more files from the 

list and use the “>” button to add them to the “Files for merging” list on the 

right side, or press the “>>” button to add all files in the list. 

It is possible to list files in a certain folder and move some or all of them to the 

“Files for merging” list, and then select a different folder and add more files 

from this new folder to the “Files for merging” list.  The system 

automatically keeps track of what files were already added from each 

directory and does not allow adding them again.   

Warning: Extra care should be taken when lsm and map files are merged 

together, as when an lsm file is selected, all map files that belong to this lsm 

are handled as one file and here the system may allow having duplicate data.  

5.3.1.2 Files for merging 

All values displayed in the file list are self explanatory and informational except for 

the Gap/Shift column, which may be modified by the user.  The Start time and 

End time values are in seconds. Once a list of files has been moved to this section, 

it is possible to do the following before you press the start button: 

1. Decide how files will be merged, in parallel of consecutively – To do this 

selects the “Parallel” or “Consecutive” radio button to specify the order 

of the merging process.  
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2. Change the order of the files on the list.   This may be very important 

when merging files consecutively.   There are two ways to change the list 

order, either by selecting a file from the list and using the Move Down and 

Move Up buttons, or by clicking on certain column captions.  It is possible 

to sort the list by Name, Start time, or Creation time by clicking on their 

column captions. 

3. Control how much Gap to add between files when merging consecutively, 

or how much time to shift files when sorting in parallel.   This function 

will allow you to line things up if necessary.   

4. When merging consecutive files, select if the beginning of the output file 

will match the beginning of the first file.  This is done by checking the 

check box labaled “Use first file start time and merge file start time”.  

5.3.2 Output files Pane 

In the “Output files” you specify the destination and name of the merged output file: 

1. Under “Folder”, specify the destination directory for your file. 

2. In the “File:” field, specify the name of the merged output file.  The output 

is always an lsm file a one or more map files.  The output map files will 

take the specified file name, appended with an ordinal number starting at 

001.  

Note: To merge into other formats, create merge.ini file in the amap folder 

and have the following lines in it.  This works only for .map files and not 

.mpx files.  

[SaveOptions] 

Plx=1 

Map=1 

Smr=0 

AsStrobed=12000            

Limit Files By 

This section will allow you to control the size of the output files by specifying a time and 

size limits for output file, and the current output file will be closed and a new file will be 

opened for output whenever either of the limits is reached. 

1. Under “Size [MB]”, specify the maximum allowed size for each output 

file.   The system has a maximum size limit of about 1.0 per file, so if you 

specify a size larger than this it automatically breaks on that size.  

2. Under “Time [Min]”, specify the maximum time allowed for each output 

file 

 

 


